IBM Applications & Tools

An introduction to what you’ll need to do your IBM job and where to find help
Table of Contents

Slide  3 : Important Steps
Slide  4 : Getting Assistance
Slide  5 : IBM Security
Slide 11 : Your Intranet Password
Slide 15 : Lotus Notes 8
Slide  43 : Sametime - IBM’s Instant Messaging Tool
Slide  51 : Intranet Labor Claiming (ILC), or 'CLAIM'
Slide  67 : eTOTALS
Slide  77 : Mobility Devices
Slide  83 : Worldwide Expense Reporting (WWER)
Slide  99 : IBM Intranet Navigation (w3.ibm.com)
Slide 107 : IBM BluePages
Slide 113 : IBM CareerSmart
Slide 117 : ISSI - IBM Standard Software Installer
Slide 125 : Finding Help or Information
Important Steps

Connectivity:

______ Follow *connectivity instructions* sent to you
______ Connect to the *IBM Network* as soon as possible

Lotus Notes:

______ Review & update your *preferences*
______ Create a *signature* to appear at the bottom of your Lotus Notes mail
______ Use a local mail file *replica*

Other:

______ Update & verify your *BluePages* record (phone, address, etc.)
______ Learn & comply with IBM policies on *security*
Getting Assistance

If you experience problems with . . .

- **IBM applications:**
  - IT Help Central at [w3.ibm.com/helpcentral](http://w3.ibm.com/helpcentral)
  - IBM Customer Service Center (Help Desk) at 1-888-IBM-HELP (1-888-426-4357)

- **IBM hardware:**
  1-800-IBM-SERV (1-800-426-7378)

- **Client-provided hardware:**
  - check with your manager for the policy on your account
  - refer to communiqués from IBM New Employee Startup
IBM Security – It’s Your Responsibility

Follow established practices and policies for protecting IBM's interests

Prepare for random audits of your security compliance

For security information:

- Go to w3.ibm.com
  - Search on keyword -> security

- Go to the IT Security website and explore links:
  - w3.ibm.com/tools/main/security

Talk to us! We’ll talk back.

Have a cybersecurity question? Ask an Expert at the Secure Computing@IBM Community
We blog and Podcast now.
IBM Security and Use Standards – ITCS300

IBM Corporate Standard ITCS300 covers IBM’s expectations regarding protection of:

- IBM workstations
- IBM confidential information

Security measures must be followed by all IBM employees, employees of IBM subsidiaries, contractors, vendors, and others authorized by IBM management to use IBM internal computer systems.

See also:  
`w3-03.ibm.com/tools/it/ittools.nsf/main/security_employeebasics`
Security Basics for You

Workstations:

- Use *keyboard/screen lock* passwords to prevent unauthorized access
- Do not share *passwords* with anyone
- *Physically secure* portable laptop computers (cable locks, etc.)
- Ensure *firewall* is active and *anti-virus software* runs regularly
- Protect your Lotus Notes *calendar* from unauthorized access
- Encrypt your *local* Lotus Notes Applications (databases)
- Ensure that the *Workstation Security Tool* is loaded

(on IBM-owned hardware only).

*WST is a diagnostic PC tool designed to check for employee compliance with workstation security requirements*

Check your PC’s status:

**Linux:**
- > More Applications > Open Client > IBM Workstation Security Tool Applet

**Windows:**
- > All Programs > Workstation Security Tool
Security Basics for You

- **IBM Confidential** (or sensitive client) information must be properly classified, labeled, protected, and locked in a secure place.
  
  *IBM Confidential information is information that, if revealed, would provide a competitive advantage in the marketplace and has some or all of its economic or other value because it is not publicly available or is not used by others* (IBM Corporate Instruction LEG 116)

- Follow IBM’s *Business Conduct Guidelines for Open Source Software*
  
  [https://w3.tap.ibm.com/w3ki07/display/OSSCProcess/OSPG](https://w3.tap.ibm.com/w3ki07/display/OSSCProcess/OSPG)

- **Pick up** printing or faxes immediately

- Adhere to *clean desk* policy - lock up confidential / sensitive information

- **Lock** desks, cabinets, etc. containing these materials

- **Shred** or render unreadable unneeded information

- Update telephone *voicemail* messages to warn callers not to leave IBM Confidential or client-sensitive messages
Security Basics for You (continued)

Encryption Solutions:

- All employees are responsible for the encryption of the following information when it is stored on removable media:
  - personal information (PI)
  - sensitive personal information (SPI)
  - confidential IBM or customer information

- Removable media includes CDs, DVDs, any removable hard disks (HDD), and USB storage devices

Review and follow data protection guidelines:

w3-03.ibm.com/tools/it/ittools.nsf/main/security_fileencryption_solutions

If you have questions, please contact your IBM manager.
Your Intranet Password
Intranet Password

- Single password for many IBM web-based applications

- Used in conjunction with your IBM Internet ID
  Lotus Notes shortname@us.ibm.com

- If one is not pre-set for you, you must create your own Intranet password; refer to Lotus Notes section for password rules

- IBM Intranet Password Homepage:
  w3.ibm.com/password

  • Create / reset password
  • Change 'auto-generated' password
Welcome to the IBM Intranet Password Web site.

You can use this site to create and maintain a single password for IBM internal Web applications. First-time visitors can create a new password and returning visitors can reset or change an existing password using this site.

When selecting a password, you must follow the password standards documented in the IBM Corporation Security Standards ITCS104.

**Create / Reset password**

Use this option if:

- your password no longer works/expired.
- you want the system to generate a new password and e-mail it to you.
- you are a new user of the IBM Password Authority.
- you have forgotten your password.
- your password is revoked.

When you click on the Reset Password link above, a new password will be sent to your e-mail address.

**Change password**

Use this option if you:

- know your password and want to change it to something that's easier to remember.
- your password is about to expire but not yet expired.

Upon clicking on the Change Password link above, you will be prompted to enter your Internet e-mail address, old password and new password twice to verify.
Questions or Comments?
Lotus Notes 8
Topics

- Critical Lotus Notes 8 Files
- Local Replica / Replication / Location Documents
- Open List – Docked / Undocked
- Workspace
- File Menu – Preferences / Security / Password
- Mail Inbox View / Action Bar / Signature / Out of the Office
- Calendar / Vacation Planner
- Managing Your Lotus Notes Mail Application
  - My Attachments
  - Archiving
  - Compacting / Encrypting
- Where to find more Lotus Notes Information and Help
Critical Lotus Notes 8 Files

These are the critical Lotus Notes files that you should back up regularly:

For **Linux** and **Windows** users:

- `<your-user-ID>.ID`
  - the ‘ID file’ allows you to log onto Lotus Notes

- **DESKTOP8.NDK**
  - contains your workspace icons and private views

- **NAMES.NSF**, or Contacts / Address Book
  - contains location documents, connection documents, user records, and personal groups

*File locations:*

Linux: `/home/<username>/lotus/notes/data`
Windows: `C:\Notes\Data`

For **Windows** users **only**:

- **NOTES.INI**
  - contains your preferences and setup and is located in `C:\Notes`
Location Documents

From the bottom right of your Lotus Notes view, click the drop-down arrow to see the Location documents that are stored in your Lotus Notes Contacts application (Address book)

- **Online**
  Use this location when you are connected to the IBM network; it is normally set to point to the Local Replica of your Lotus Notes mail file

- **Offline**
  To work with your mail when not connected to the IBM network, your Lotus Notes session should be in this location mode; it stops replication

*Note: the locations may be named differently*

Use the arrow to switch locations, or to **Edit Locations**… in your Preferences
Local Replica of your Mail File

- Enables better response time

- Allows access to Lotus Notes mail when not connected to IBM network (while traveling; during power outages, etc.)

- **Local Replica**: an *exact copy* of your server mail file, located on *your* hard drive

- **Replication**: synchronizes the *local* and *server* copy of your mail file
‘Replication’ synchronizes local & server mail files
Replication Page

To force replication, click **Start Now**
Open List in Docked or Undocked format

The Open List offers . . .

- Type-to-find feature
- Access to applications & bookmarks
- Right-click icons to dock or undock the Open List

'Docked' format with Bookmark bar

'Undocked' format with pull-down menu
Lotus Notes *Workspace*

**Docked:**
Click the **Applications** icon

**Undocked:**
Click the **Open button** and type `'workspace'` in the search field

**Workspace Icons** link to your:
- Mail file
- Address Books
- Bookmarks
Preferences

File > Preferences
Review & update your preferences
Use **Security Basics** to change your Lotus Notes password.
Lotus Notes Password Recommendations

Your password **must**:

– be at least **eight** (8) characters in length

– be a mix of **alphanumeric** characters
  • avoid numbers in first/last position
  • sometimes requires more than one number or other complexity

– *not* contain your name or ID
– *not* contain words from dictionary
– *not* be re-used after at least eight iterations

– be changed at least every **ninety (90) days**
  • a reminder is generated 68 days after password has been changed
  • after 90 days, password expires and mail access is not allowed until password is changed

*Hint:* Set password so the **same one** can be used with other applications
## Lotus Notes Inbox

The Lotus Notes inbox is displayed with a list of emails categorized under "High Importance." The emails are listed with the sender's name, subject, date, and size. Some examples of emails include:

- **Karen Barrer**
  - Subject: Closing out a deliverable
  - Date: 11/06/2009 08:50 AM
  - Size: 5K

- **Rodney Mulrooney**
  - Subject: Re: Rogers Onboarding => ADDITION
  - Date: 11/03/2009 03:13 PM
  - Size: 40K

- **D03OSM00**
  - Subject: Warning! Action required to reduce
  - Date: 08/25/2009 04:04 AM
  - Size: 9K

- **Madeleine McBroom**
  - Subject: * TRACKING TABLE * (SAVE) ROGE
  - Date: 06/09/2009 11:52 AM
  - Size: 171K

### Calendar Events

- **Lynda J Mendel**
  - Subject: Follow-up to meeting to discuss 2 to 111/12/2009 02:40 PM
  - Date: 11/12/2009
  - Size: 3K

- **Lisa Schneider**
  - Subject: Information Update - Description has been updated
  - Date: 11/10/2009 02:43 PM
  - Size: 342K

- **Amanda Arnold**
  - Subject: Information Update - Description has been updated
  - Date: 11/10/2009 12:38 PM
  - Size: 28K

### Normal

- **IBM EMPLOYEE SERVER**
  - Subject: Your Health and Insurance Enrollment
  - Date: 11/12/2009 06:37 PM
  - Size: 13K

- **Marvin Pace**
  - Subject: Re: 11/11 Meeting Minutes - Rogers
  - Date: 11/12/2009 05:55 PM
  - Size: 9K

- **Kenneth Bell**
  - Subject: Fw: RPM Upgrade...Reinstall RPM
  - Date: 11/12/2009 05:53 PM
  - Size: 8K

- **Lynda J Mendel**
  - Subject: Fw: Scope for 2 to 1 Workstation project
  - Date: 11/12/2009 02:14 PM
  - Size: 18K
Send an e-mail

Select ‘New’ from the Action Bar
Create a closing message (name, contact info) . . .

More > Preferences > select Signature tab

Check out the E-Mail Signature Generator at http://signature.innovate.ibm.com/index
More Options

Use More button for Out of Office message
Out of Office Message

Things you *may* include in your **Out of Office** message text:

- **Dates** you are out of the office
- **Backup’s name**, e-mail address and external phone number
- **Manager’s name**, e-mail address and external phone number
- **Other emergency contact info**
Out of Office message

To set an **Out of Office** message:

1. Enter or select **Leaving Date** and **Returning Date**

2. Enter text to be included in your out-of-the-office message in the **Additional body/text** field

3. Click the **Enable and Close** button to turn the Status indicator to **On**

**Notes:**

- The **Reset Defaults** button quickly clears fields of previous entries
- Check box to automatically **Append return date to subject**
Folder options
Lotus Notes 8 Calendar

One Month view is shown. Choose your preferred view: Two Days, One Week, etc.
Lotus Notes Vacation Planner

- Use the **Vacation Planner** to track your yearly vacation schedule in Lotus Notes
- It is a standalone Lotus Notes application -- it runs locally and will not replicate with any server
- Schedule full or half-day vacation days, site holidays, and more

For installation and usage details, go to:

*Linux:*  http://ibm.biz/BdxR6F

*Windows:*  w3-01.ibm.com/hr/us/hrforms/vacplanner.html
Managing Your Lotus Notes Mail Application

Mail File - Size Limitations

- A mail file-size control tool enforces an upper-size limit on all mail applications
  - mail size limit is 300MB
  - you will receive warning notes when your local mail application approaches 285MB

- ‘Mail jail’
  - when you exceed your mail-size limit and do not take action . . .
  - you will not be able to create/send a new memo, reply, or forward any memos until you reduce your mail file size
Ways to Manage Your Lotus Notes Mail File

**My Attachments**
A Lotus Notes tool that removes attachments from your mail file and calendar and stores them locally on your workstation.

**Archiving**
Allows you to move selected documents to a local archive on your workstation.

*Note:* To make the local copy of your mail file run more efficiently, compact it after removing attachments and archiving documents.
My Attachments

- Analyzes your mail file and makes a list of attachments
- Identifies the attachments and any duplicates
- Moves selected attachments to a local application created by the installation of the tool (duplicates are stored only once)
- Places a link in the note that originally held the attachment pointing to the attachment at its new location
- Allows you to easily identify and delete duplicates of attachments you no longer want, keeping just one copy

For most users, MyAttachments can be installed from the IBM Standard Software Installer (ISSI) at w3.ibm.com/download/standardsoftware

WARNING: Do not use ISSI on non-IBM, client-provided workstations
Archiving Your Lotus Notes Documents

- Archiving moves documents and stores them on your *local hard drive*
  - Reduces the size of your mail and makes it more efficient
  - Allows you to select documents that are no longer current (but still need to be retained) and move them to your workstation

- IT Help Central has solutions for *mail archiving* in Lotus Notes 8 at [w3.ibm.com/helpcentral](http://w3.ibm.com/helpcentral)
Compacting Your Notes Mail Application

After reducing the size of your *local* mail file, *compact* it to improve efficiency:

1. right click the icon for your *local* mail application
2. select **Application → Properties**
3. select the **i** tab
4. click **% used** button, if below 90%...
5. click **Compact** button

Notice your mail file size
Encrypting an Application

- Convert data to a format readable only by the intended recipient
- IBM requires that you **encrypt** local mail applications, mail archives, and ‘MyAttachments Repository’ on your workstation

**Do not** encrypt the following, as it will make them unusable:

**Your Lotus Notes Contacts book**
- **Linux**: `/home/<username>/local/notes/data/names.nsf`
- **Windows**: `C:\notes\data\names.nsf`

**Your Lotus Notes bookmarks**
- **Linux**: `/home/<username>/local/notes/data/bookmark.nsf`
- **Windows**: `C:\notes\data\bookmark.nsf`

**MyAttachments Tool**
- **Linux**: `/home/<username>/local/notes/data/atchtool_<your_name>.nsf`
- **Windows**: `C:\notes\data\atchtool_yourfirstname_yourlastname.nsf`

For details on encryption, go to [w3.ibm.com/helpcentral](http://w3.ibm.com/helpcentral)
Help in Lotus Notes 8

1. Help Contents  - general help topics
   - Displays in a separate window

2. Dynamic Help  - help related to the current task
   - Displays in a side pane; can also be accessed by pressing F1

Find pointers to current Lotus Notes information & resources at: w3.ibm.com/ibm/resource/lotusnotes.html
Sametime

IBM's Instant Messaging Tool
IBM Lotus Sametime

Located within Lotus Notes 8 or:

Linux: Computer > More Applications > Office
Windows: All Programs > IBM Lotus Sametime Connect
Quick Find

Type **name** in Quick Find box

Select name to **chat**

**Right-click** for options

You can chat without adding person to Contacts list.
Chat Window

- Status
- User photo and info from Blue Pages
- User message and location
- Screen captures
- Spell checking
- Emoticons and pictures
- Rich text formatting
- Send links
- Send files

Image of a chat window showing various features such as user profile, chat messages, and options for formatting and sending files.
Chat History (1 of 2)

Transcripts

7/17/07
5/31/07
5/22/07
3/19/07
3/13/07

Cynthia L. Johnson
IBM US S&D Client Advocacy and Business Operations, Notes Client & Collaborati...
930-3188 / 1-845-689-2254 / at Home Office
I am available @ at Home Office (Sametime 7.5.1)

cljohn@u... Hi Chris... do you have a minute for a ST question regarding Rendezvous?
5:32:11 PM

christoph... Sure, what's up?
5:32:18 PM

cljohn@u... I posted a question to the forum and no one responded
5:32:45 PM

• and I can't copy it, but anyway...
5:32:56 PM

• a team member of mine installed the latest code from Dan and Rendezvous no
   longer works
5:33:39 PM

• receives an error when trying to add the plug-in
5:33:52 PM

christoph... I recommend contacting Harry Reichlen, he's the solution owner for
5:36:42 PM

Rendezvous (eAC)

cljohn@u... Ok, will do. Thanks.
5:37:07 PM

christoph... np
Chat History (2 of 2)

Preferences

Chat History

Saving chat transcripts
- Default action: Automatically save chats
- Save to local file: C:\Documents and Settings\Administrator\SametimeTranscripts
- Additional folders will be added to this location to organize saved transcripts by user and date
- Delete saved transcripts after this number of days: 365
- Local transcript file folder size: ... KB
- Delete Existing Transcripts...

Displaying daily chat history
- Display the saved transcript between two users for the current day in the chat window
- Display background highlighting when displaying saved transcripts in chats

Restore Defaults  Apply

OK  Cancel
Preferences

- Fonts, sizes, colors
- Language
- Spell checking
- Chat history
- Default file transfer location
- Audio
- Privacy
- Notifications
- Emoticons and icons
- Adding additional communities
From **w3.ibm.com**, click **IT Help Central**; search on **‘Sametime’**
Intranet Labor Claiming (ILC)

A web-based application used to report labor
Why Do We 'CLAIM'?

- **Billing** – actual labor utilized → IBM’s paycheck
- **Reconciliation** – projected vs. actual hours to do job
- **Project Tracking** – verify project is financially on track
- **Project Planning** – benchmarking
- **Project Negotiation** and **Re-negotiation** – utilize realistic labor information
- **Forecasting for Future Projects** – predict costs for similar projects
CLAIM Tips

- CLAIM labor *every week by Friday* (unless otherwise instructed)
- Include your overtime
- Use correct CLAIM codes (provided by manager, technical team leader, etc.):
  - *Account Code* (aka Project ID, previously called LPID)
  - *Work Item* (relates to business area you are in)
  - *Activity code* (relates to what you do)

- Avoid being *delinquent* in submitting labor; management receives reports showing who did not submit labor hours

- Submit labor in advance for the *non-billable* time you will be out; billable hours must be submitted within week worked
Accessing ILC

Double click the ‘red clock’ ILC icon on your desktop

< OR >

**Linux:**
1. Click Computer button
2. Select: More Applications > Intranet Labor Claiming

**Windows:**
1. Click the Start button
2. Select: All Programs > eClaim > Intranet Labor Claiming
1. Enter your Intranet user ID *shortname@us.ibm.com*

2. Enter your IBM Intranet password

3. Click the **Login** button
ILC Profile

- The first time you access ILC, you will be asked to configure your ILC profile.
- You can also make changes to your profile by clicking: **Edit → User Profile → Edit**
Setting your ILC Profile Preferences can make entering labor easier:

- Prefill with labor items
- Prefill with current...
- Advance the period ending date...
ILC Profile Labor Items

Sample Labor Items stored in an ILC User Profile
Searching for and Adding a Work Item

1. Click Add Work Items
2. Type search information into one or more of the fields
3. Click Search button
4. When search completes, highlight a Work Item
5. Click Add, then
6. Click OK
A Work Item is Added

Before posting hours to a **Work Item**, you must first select an **Activity**.
You can edit this field to make an activity description more recognizable.
When you have selected an activity for a Work Item, it will appear in the Activity Description field.
Updating a Work Item

Highlight a Work Item → Select Edit

Use this view to perform various actions:
Add Overtime or Add Labor Item to Profile
‘Saving’ vs. ‘Submitting’ Labor Hours

Click **Submit** to enter your labor each week
Summary

1. Click the appropriate **Week-ending** date

2. Click the appropriate **Work Item** line

3. Enter the **regular hours** you worked each day

4. If necessary, create an **Overtime** line by double-clicking in the Work Item’s OT column

5. Enter **Overtime** hours

6. **Repeat** for other Work Items that you use

7. Click **Submit**
   *Verify there is a **green** checkmark next to the Week-ending date*
Intranet Labor CLAIMing for End Users
Learning@IBM web lecture, course code Itu7397f

lt.be.ibm.com/services/weblectures/dlv/Gate.wss?
handler=Offering&action=index&customer=ibmintra&offering=asd

ILC User's Guide

bms1.sby.ibm.com/Documentation/ILC/nw3ILCDoc.htm
eTOTALS

Terminal Oriented Time and Labor System
Who Uses eTOTALS

Regular employees:

- Enter *exceptions* only *(paid* overtime, personal illness, holiday worked, unpaid absence)*

- If there are no exceptions, the eTOTALS timecard is *automatically submitted* weekly for regular employees

- Do *not* use for *paid time off* (personal business, vacation, regularly scheduled holiday)

Supplemental employees:

- Must submit a time card weekly in order to be paid
Welcome to eTOTALS

eTOTALS is the intranet web interface to the TOTALS application. Use eTOTALS to record your time and labor for payroll processing.

eTOTALS is only available to IBM US employees and requires an IBM intranet ID and password.

To continue, check the availability times below and select sign in to eTOTALS.

Time cards should be entered and signed each week by Friday 05:00 p.m. Eastern standard time in order to ensure that they are processed on time.

All supplemental employees must mark either the days that they worked or a full week, not both.

<table>
<thead>
<tr>
<th>TOTALS may be unavailable during the following times:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Day</strong></td>
</tr>
<tr>
<td>---------</td>
</tr>
<tr>
<td>Monday to Tuesday</td>
</tr>
<tr>
<td>Wednesday</td>
</tr>
<tr>
<td>Sunday</td>
</tr>
<tr>
<td>Daily</td>
</tr>
</tbody>
</table>

For TOTALS questions contact the TOTALS Help Desk at 1-800-795-9875

Terms of use
Employee Information

Before you enter time and attendance data the first time, review and update your Employee Information screen.
Time card calendar – Current Week-ending Date

Click on week ending date to view specific time and attendance detail for that time card. If time card is shown as "not available", click on week ending date and request archive retrieval.

Employee name: MENDEL L J

One highlighted week needs action.

Messages displayed here

Immediate attention required
If you enter eTOTALS daily, be sure to save before you close the website.

Click on '?' to view help text for each activity.
**Additional Hours Worked (Overtime)**

<table>
<thead>
<tr>
<th>Activity</th>
<th>Sat</th>
<th>Sun</th>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Thu</th>
<th>Fri</th>
<th>Full week</th>
<th>Add row</th>
</tr>
</thead>
<tbody>
<tr>
<td>Non-scheduled day</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Additional hours worked</td>
<td>Add</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Emergency work (call in)</td>
<td>Add</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Holiday</td>
<td></td>
<td></td>
<td></td>
<td>Add</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Holiday worked</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Industrial accident</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Individualized work schedules</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(IWS) or appurtenant</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Click **Add** under the day in question for additional hours worked.
- Fill in the pop-up with the additional time worked.
- Click **Save**.
- Click (+) for an additional row if you have more than one entry per day, the activity window updates after every **Save**.
Summary

### View summary

**Summary for week ending 01 October 2004**

Please review. Then press submit.

Please note abbreviations like 'hr' means 'hour', 'hrs' means 'hours', 'min' means 'minute' and 'mins' means 'minutes' will be used in this page.

**Employee name:** TESTER088 I M

<table>
<thead>
<tr>
<th></th>
<th>Sat</th>
<th>Sun</th>
<th>Mon</th>
<th>Tue</th>
<th>Wed</th>
<th>Thu</th>
<th>Fri</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Regular hrs</strong></td>
<td></td>
<td></td>
<td>8 hrs</td>
<td>8 hrs</td>
<td>8 hrs</td>
<td>8 hrs</td>
<td>8 hrs</td>
<td>40 hrs</td>
</tr>
<tr>
<td><strong>Additional hrs</strong></td>
<td></td>
<td></td>
<td>1 hr</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1 hr</td>
</tr>
<tr>
<td><strong>Total worked</strong></td>
<td></td>
<td></td>
<td>9 hrs</td>
<td>8 hrs</td>
<td>8 hrs</td>
<td>8 hrs</td>
<td>8 hrs</td>
<td>41 hrs</td>
</tr>
</tbody>
</table>

*Terms of use*

- Click on **View Summary** on the main screen to review the hours you recorded, and certify that they are correct.
- Click on **Submit** to enter your time.
Getting Help with eTOTALS

**eTOTALS Help Desk:**
- 1-800-796-9876

**IBM Help Desk:**
- 1-888-IBM-HELP or 1-888-426-4357

**Payroll Services/ eTOTALS Tutorials:**
- [w3-01.ibm.com/hr/us/payroll/payrollsvcs/e_totals.html](http://w3-01.ibm.com/hr/us/payroll/payrollsvcs/e_totals.html)
Questions or Comments?
Mobility Devices

What you will use to communicate at IBM
Means of Communication

- **Business Phone at IBM site or home office**: for your work-related calls

- **Calling Card**: for long distance calls made from non-IBM sites and when traveling; an alternative to a cell-phone; you receive this card automatically when you apply for a corporate American Express credit card

- **Conference Call Numbers / Bridge Lines**: if approved, to be used for work-related conference calls, 1-800, 866, 877 numbers, etc.

- **Cell Phones / Pagers / wireless handheld devices (Smart Phone, BlackBerry), etc.**: if approved
Setting Up a Conference Call Number / Bridge Line

- **Contact your Manager**
  - Management approval is required
  - Your manager may have detailed instructions for you

- **IBM US Audio Conferencing services**
  - contact AT&T Teleconference Customer Care at (888) 414-3165 or (205) 206-2301
  - Calls are billed at the dept level; however, you have the ability to charge your calls to a client project
  - Charging to a client project requires the account ID for the project

**Important Note for IBM Confidential Information**
Do not place the passcodes for IBM-only conference calls on a non-IBM calendar unless you restrict access to your calendar.
Mobility Device / ‘Connection Tools & Services’ Guidelines

- First, obtain **management approval** using the **Connections Tools Portal**

- IBM allows the use of **one mobility device**, either:
  - Supplied from the IBM Corporate Managed Program
  - Cell phone/PDA/BlackBerry with ‘personally-liable’ service
  - Pager leased through IBM contract

- **Equipment expenses** are **not** reimbursable by IBM
  (personal device, accessories, carrying case, etc.)

- The **services** portion of your bill is reimbursable
  (the monthly charge - **up to specific limits**)

---

**Corporate Instruction CIO 128**
**Connection tools & services expense eligibility**

From **w3.ibm.com**, search for:
**Corporate Instruction CIO 128**
Getting Reimbursed

- Use **Worldwide Expense Reporting** (WWER) for reimbursement of *allowable* expenses

- IBM reimburses *actual* expenses only

- **Reimbursement limits** (with management approval)
  - $40/mo for a cell phone (personally liable)
  - $40/mo for a pager (billed to department)

- Amounts above these are considered ‘*exceptions*’ and can require additional approvals
Questions or Comments?
Worldwide Expense Reporting (WWER)

A web-based intranet application used to process expense accounts
Before You Incur an Expense...

- Get your **manager’s approval**
  - Use the **ITD eXpense Management Tool (XMT)** for all expenses other than mobility *(located on Lotus Notes server D01DBR06)*

- Book your travel with the **OnLine Travel Reservations (OTR)** tool from the link at the IBM Travel web site or:
  - From [w3.ibm.com](http://w3.ibm.com), search for **OnLine Travel Reservations**.
    
    *Note:* You may incur a fee if you use the American Express Travel Agency

- Use an IBM preferred **rental car supplier** (Avis, Enterprise, Hertz, and National)

- Use the **hotels** with IBM-negotiated contracts

- Know the per-diem **meal allowance** limits for your destination
Travel policy scope & responsibilities

Travel

Attention: If you are planning travel to any country in Africa, you must review this Lotus Notes document before arranging travel. If you cannot access Lotus Notes, send an e-mail to travel@ca.ibm.com.

Welcome to the You and IBM Global Travel Portal. The portal contains all of the policies, rules, and guidelines related to IBM business travel. Use the Select your destination tool below to quickly locate travel information.

If this is your first time visiting the portal, be sure to read the IBM Global Travel Portal section below for important information about navigation tools.

Note: IBM Employees should not disclose IBM business-travel policy or rates to others outside of IBM without the consent of Global Travel.

IBM Global Travel Portal

Executive message to IBM employees

Current IBM travel restrictions

Cross border travel: Mandatory requirements

Select your destination

Find information about your destination: select your destination country and click GO

Tools and resources

Online Travel Reservations (OTR)

World Wide Expense Reimbursement - WWER
Expense Reimbursement

United States

Assistance for Visually Impaired

The Expense Reimbursement (WWER) application is to be used only for:

- Submitting travel and miscellaneous business expenses.
- Processing awards by managers or their preparers.

STOP

It is each employee’s responsibility to comply with IBM expense reimbursement guidelines, and the manager/approver responsibility to review that the expenses are actual, reasonable and for necessary business purposes.

Falsification of expenses or intentionally submitting non-reimbursable expenses for payment violates IBM’s core value of Trust and Personal Responsibility, IBM Policies, and Business Conduct Guidelines.

If you are unsure about an expense claim, refer to the IBM expense reimbursement guidelines or discuss it with your manager.

By launching this application I am confirming that

- I have read and understood the Privacy & security section below.
- I have read and understood my country expense policy and know that I am responsible for compliance to said policy.
Welcome Screen

- **New** button
- **Open** button
- **Print** button
- **Status** button
- **Send Copy** button
- **Delete** button
- **Prepare** button
- **Refresh** button
- **Card Data** button
- **Expense View** button
- **Send Note** button
- **Profile** button
- **Help** button
- **Sign Out** button

- **My Reports**: Expense Reports sorted by status
- **Welcome Panel**: common expense report actions
- **Work Folder**: forms awaiting your approval or forms on which you've been copied
- **Templates**: draft forms which have been saved by you for re-use on future reports
- **Attention Panel**: outstanding card expenses, cash advances or expenses requiring your approval
- **Helpful Links**: Travel policy bookmark

**Welcome**

- Employee Name
- Expense Reimbursement

**Attention**

- Create a new report
- Prepare an expense report for another person
- View & Edit my reports
- View report help
- Access my employee profile information
- Access my application preferences
- Access my application lists
- Retrieve completed reports

**Card Expenses**: You have 43 outstanding charges totaling 9093.34 USD

- M3 of the 43 charges are past due
Card View

Select the Card View icon in the Tool bar or from the Attention section of the Welcome panel.

- View applied card data by related report information (open the report) and status.
- Mark applied expenses as completed to help reconcile card expenses to monthly corporate card statements.
Creating a new report

To begin a new report:

• select File > New from the top menu,
• select New icon in the tool bar,
• click on Create a new report in the Welcome screen
Report Information Screen

- enter a **Business Purpose**
- select **Category**
- click **Next**
Expense Entry Screen

1) Apply Expenses using buttons Card Expenses or Out of-pocket Expenses for any corporate card transactions and manually entered expenses.

2) Complete Report using toolbar button.

For expenses that are directly reimbursable to you (i.e., cash expenses), click on the Out-of-Pocket button or the link in Section 1) below.

Click on the List button to switch to a list view.

View list of required Receipts.

View or edit Accounting (Charge to) information.

View possible Exceptions and applicable Policies.

Click for Totals.

Add Comment(s) to your report.

View or edit Report Information.

When you have finished entering expenses, Save & Submit.

View form Status.

File Edit View Help

Report Information Save & Submit Save Print Status Comment Help

Apply Card Expenses [40 available] or Out-of-pocket Expenses

Employee Name: Expense Report: Meeting with ABC Company to Discuss Proposal

Report Total: 0.00 USD
Reimbursable Amount: 0.00 USD

© 2012 IBM Corporation
### Applying Card Data

**Actions:** Use 'Edit' to view/edit expense before applying to report. Use 'Apply' to add expense immediately.

<table>
<thead>
<tr>
<th>Expense</th>
<th>Vendor / Description</th>
<th>Bill Date</th>
<th>Card</th>
</tr>
</thead>
<tbody>
<tr>
<td>Miscellaneous Auto</td>
<td>PD US AUT 1</td>
<td>07/24/11</td>
<td>1000</td>
</tr>
<tr>
<td>Miscellaneous Auto</td>
<td>PD NONUS AUT 1</td>
<td>07/24/11</td>
<td>1000</td>
</tr>
<tr>
<td>Air Travel (Expensed)</td>
<td>HILTON GARDEN INN</td>
<td>07/08/10</td>
<td>1000</td>
</tr>
<tr>
<td>Hotel</td>
<td>RENAISSANCE HTLS &amp; R...</td>
<td>07/07/10</td>
<td>1000</td>
</tr>
<tr>
<td>Hotel</td>
<td>HAMPTON INN</td>
<td>07/05/10</td>
<td>1000</td>
</tr>
<tr>
<td>Meal</td>
<td>RED LOBSTER</td>
<td>07/05/10</td>
<td>1000</td>
</tr>
<tr>
<td>Hotel [eFolio]</td>
<td>DOUBLETREE TULSA DO...</td>
<td>07/01/11</td>
<td>1003</td>
</tr>
<tr>
<td>Car Rental/Hire (Apply as Car Rental/Hire - Gasoline/Petrol)</td>
<td>ZZZ BUSINESS</td>
<td>06/06/11</td>
<td>1000</td>
</tr>
</tbody>
</table>

- **Edit:** expense selected is displayed in the work pad for review prior to applying
- **Apply:** expense is automatically applied, if possible (all fields pre-filled)

**Note:** Retain all receipts -- hotel bills, emergency supplies, ground transportation, meals, parking, etc.

**Always** use your corporate American Express credit card for business expenses where allowed.

- When you file an expense report, the system will instruct you to attach the ‘required original receipts’ as a scanned image or mail a hardcopy with the transmittal form to IBM in Endicott, NY
- You will not be reimbursed until the receipts are received and processed
To enter expenses which are payable to you:

- select **Out-of-pocket Expenses** from the Expense Entry Screen
  – or –

- click **select . . .** from the Spreadsheet view

- enter the Date - select the *Calendar icon* or enter a date manually

- enter the **Amount** of the incurred expense. Certain expense categories have limits (the maximum amount you can submit per expense type.)
Entering Accounting /"Charge to" Information

1. Enter the **Description of Account** and select **Services Project (BMS)** in the *To be charged to:* field
2. Enter the **Account/Project ID** for your project
3. Click **Lookup** to prefill the fields
4. Click **Done** to save the ‘charge to’ information entered and exit **Charge to Names**

**Attention!** Expenses not charged to a client account, go against **Default Accounting** (your department)
Submitting your expense report

When all expenses have been entered, select **Save & Submit** to begin the expense report submission process.

Any **required receipts** or **policy exceptions** requiring your action will be displayed. Attach softcopy receipts or enter any required explanations.

Select **Next** to continue.
The Summary and Submission screen shows the amounts due directly to you and directly to the corporate card.

- **Report Total**: Total Amount of Expenses Submitted
- **Total Adjustments**: Includes non-reimbursable amounts
- **Total Reimbursable**: Total Amount of Reimbursable expenses; Amount to be paid to Corporate Card and/or Employee
- **Credit Card Remittance**: Amounts due to Corporate Credit Card Company
- **Due Employee**: Amounts due to employee

Adjust the amount of the corporate card payment by directing funds from the Due employee amount.

- click on the **Adjust** button:
- select **Add Non-reimbursable**. This will automatically the non-reimbursable amount to the corporate card payment and deduct this amount from **Due employee**.
select **Save & Submit** to submit your expense report for processing and payment
• remember to send in any required **receipts**
• select **Report Routing** . . . button
• click the **edit** link next to the applicable **Copy**, **Review**, or **Approver** to change the routing of the current report
WWER US - WWER US Tutorial

The following tutorial is available as an introduction to WWER and contains the submission of a sample expense report.

Please click the link below to view an interactive WWER tutorial which displays the submission of a sample expense report.

Viewing Tutorial on the Web:

<table>
<thead>
<tr>
<th>Section</th>
<th>Contents:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section 01</td>
<td>Overview / Application Sign On</td>
</tr>
<tr>
<td>Section 02</td>
<td>Verification of Your Profile Information</td>
</tr>
<tr>
<td>Section 03</td>
<td>Beginning Your New Expense Report (ER)</td>
</tr>
<tr>
<td>Section 04</td>
<td>Card Data - Air Travel (Including Special Accounting)</td>
</tr>
<tr>
<td>Section 05</td>
<td>Card Data - Hotel Expense</td>
</tr>
<tr>
<td>Section 06</td>
<td>Expenses Tab</td>
</tr>
<tr>
<td>Section 07</td>
<td>Completion Tab</td>
</tr>
<tr>
<td>Section 08</td>
<td>Checking the Status of Your ER</td>
</tr>
<tr>
<td>Section 09</td>
<td>Web Site - Sources of Help</td>
</tr>
</tbody>
</table>

Are you looking for a specific tutorial page? Check out this index.
IBM Intranet Navigation (w3.ibm.com)
From the Home tab on w3.ibm.com, sign in to receive personalized content.
You’ll see additional tabs appear on the w3 page header.
The ‘Home’ Tab on w3

From the Home tab,

- Click **Edit Profile** to update your w3 profile
- Search **Communities** or **BluePages** for info about IBMers
- Search **IBM** web pages, communities, forums, and internal info.
1. The ‘My w3’ tab

2. Alerts and notifications
3. Icons of Progress
4. Featured topics
5. Headlines
6. Connect and share
7. Welcome to My w3
8. Innovation @ IBM
9. Search
10. Quicktivities
11. Ask an IBMer
‘My w3’ tab - Your intranet page

- Search:
  - For people
  - For content on w3 and IBM.com
  - **Lotus Connections** to find content in Connections Communities, Profiles, Blogs, Activities, Wikis or Files
  - The **top searches** and the **most popular pages** on w3
‘My w3’ tab - Your intranet page

– **Quicktivities**: Access links essential to your work, as well as tools designed to help you work more effectively with other IBMers.

– **Ask an IBMer**: Driven by the *IBM Answers* site, this portlet lets you ask questions, find solutions, and share answers with other IBMers — whether solving technical problems or learning more about how IBM works.
The ‘Career and life’ tab offers all the following and more:

- Act now
- Your money
- Your life and health
- You and IBM news
- Your career

Click the ‘You and IBM homepage’ link for HR information.
Review & update: Your personal information (About you)
IBM BluePages

... Continuing the IBM w3 Web Tour
The Online IBM Corporate Directory
IBM BluePages

Single user interface for finding information, skills, and expertise throughout IBM

- **IBM Corporate Directory**
  - find important information about your IBM colleagues:
    - phone number
    - address
    - e-mail address
    - reporting structure

- **Employee Profile**
  - update the information in your record
    - phone number
    - skills
    - experiences
    - interests, etc.

This module will show you:
- where to find BluePages
- how to update your profile
- how to perform a simple search
IBM BluePages

- You can do a **quick search** of BluePages by name from [w3.ibm.com](http://w3.ibm.com)

OR

- Use [w3.ibm.com/bluepages](http://w3.ibm.com/bluepages) for more advanced searches.
Edit your BluePages’ profile & add your:

- Phone numbers (mobile/pager/etc.)
- Backup’s name
- Preferred work address
Rometty, Virginia (Ginni)
IBM employee, Regular
IBM USA
IBM CHQ, Executive Offices
President and Chief Executive Officer
Executive
Assistant: Burns, Aimee L.

Armonk, NY United States
Building: CHQ1 | Floor: 3 | Office: 3B-18N-3

Local time:
20:38 | 8:38PM

My preferred contact method is e-mail
Phone: 1-914-499-4200 (T/L: 641-4200)
ITN: 26414200
E-mail: grometty@us.ibm.com
Notes mail: Ginni Rometty/Southfield/IBM@IBMUS
Add to:
Notes address book  My BluePages list  vCards

People managed
For multiple results:
- review details - location, job role, etc.
- click name to see individual record
IBM CareerSmart

Plan Your Development – Gain Skills – Track Progress
IBM CareerSmart can help you reach your goals ...

**PLAN** your development

**GAIN** skills and experience

**TRACK** your progress

IBM CareerSmart is a simple approach that guides you to:
- Plan your development by creating a plan and setting goals for your development
- Gain skills and experience by helping you find learning opportunities and to gain skills and experience to meet your goals
- And to Track your progress by helping you measure and share your progress against your plan and goals.
Access IBM CareerSmart

Access the IBM CareerSmart web site:

• from your Career and Life tab on w3.ibm.com

• w3-03.sso.ibm.com/hr/careersmart/html/home.html
Questions or Comments?
ISSI
IBM Standard Software Installer

Your web-based source for downloading IBM-licensed applications

Note: Do **NOT** use ISSI to download software onto non-IBM, client-provided workstations.
To find ISSI, go to w3.ibm.com

Essential links → IT tools and support → IBM Standard Software Installer

< or >
type ISSI in the search field & click GO
IBM Standard Software Installer Home Page

The IBM Standard Software Installer (ISSI) is IBM’s premiere workstation software delivery tool. It consists of two components:

- The ISSI Web-based Catalogs
- The ISSI EZUpdate Service

ISSI Web-based Catalogs

The ISSI Web-based catalogs provide automated installation packages for a wide variety of software applications which are standard across IBM, a geography, or a business unit. For additional information, please see the ISSI User Guide.

All ISSI software application packages are strictly intended for IBM business use only, as defined by IBM Business Conduct Guidelines.

Most employee workstations are preconfigured with the ISSI client software. If necessary, the user may run the ISSI installation program as specified in the setup instructions.

ISSI EZUpdate

The ISSI EZUpdate service prompts users to install required and recommended software on their computers. The service runs in the background on employee computers. It identifies applications or software updates which are either required or recommended for installation. Typically, it allows the user to install packages immediately or schedule the installation at a convenient time. For additional information, please see the EZUpdate User Guide.
3. Select your Operating System
4. Search the Catalog
Installing the Software

- Read the application description and installation instructions
- Ensure your workstation is compatible with the application
- Note where licenses are required; if so, contact your manager for necessary approvals
- Close all programs before installing software
  - except AT&T Net Client and ISSI
  - exit Sametime so you won’t receive messages
- Do not touch the keyboard while installing software
Installing...

IBM Standard Software Installer

IBM Standard Software Installer

IBM ZapNotes

Checking for program updates...Complete!
Locating a source server...Complete!
Accessing package install code...Complete!
Checking product prerequisites...Complete!
Accessing product source files...

Overall progress 93%

Cancel
Completing the Installation

When the installation is complete, you will see a *dialog box* with information displayed…

- Click **OK** to finish the installation

- A *reboot* of your workstation may be required after the installation
Finding Help or Information

IBM Help Central and w3.ibm.com
Important Steps - Recap

Connectivity:

_____ Follow *connectivity instructions* sent to you
_____ Connect to the *IBM network* as soon as possible

Lotus Notes:

_____ Review & update your *preferences*
_____ Create a *signature* to appear at the bottom of your Lotus Notes mail
_____ Use a local mail file *replica*

Other:

_____ Update & verify your *BluePages* record (phone, address, etc.)
_____ Learn & comply with IBM policies on *security*
Thank You!